
Tạp chí Đại học Thủ Dầu Một, số 1 (14) – 2014 

   67 

 

 

XAÂY DÖÏNG MOÂ HÌNH VAÄT THEÅ BA CHIEÀU, VEÕ HÌNH 

CHIEÁU THÖÙ BA VAØ HÌNH CAÉT TRONG VEÕ KYÕ THUAÄT 

Ngoâ Baûo 

Trường Đại học Thủ Dầu Một 

 

TÓM TẮT 

 Phần mềm SolidWorks 2009 là một ứng dụng công nghệ tin học trong việc vẽ hình 

chiếu trục đo, vẽ hình chiếu thứ ba và vẽ mọi hình chiếu, hình cắt theo ý muốn, góp phần 

giải quyết khó khăn trong dạy và học môn vẽ kỹ thuật. Bài báo này giới thiệu cách sử dụng 

phần mềm SolidWorks 2009 để vẽ hình chiếu trục đo khi biết trước hai hình chiếu vuông 

góc gồm hai bước: Bước 1, vẽ hình chiếu trục đo với 15 thao tác; Bước 2, dùng hình chiếu 

trục đo để vẽ ba hình chiếu vuông góc với 5 thao tác. Với việc sử dụng phẩn mềm 

SolidWorks 2009, ta sẽ giải quyết được khó khăn của môn vẽ kỹ thuật trong các trường hợp 

vẽ hình chiếu trục đo, vẽ hình chiếu thứ ba khi cho trước hai hình chiếu vuông góc và vẽ ba 

hình chiếu vuông góc khi cho trước hình chiếu trục đo. 

Từ khóa: Hình chiếu trục đo, hình chiếu vuông góc, hình chiếu đứng, hình chiếu cạnh, 

hình chiếu bằng, vật thể ba chiều. 

*

1. Đặt vấn đề 

 Khi dạy và học môn Vẽ kỹ thuật, chúng 

ta đều gặp dạng bài tập vẽ hình chiếu trục 

đo, vẽ ba hình chiếu vuông góc, vẽ hình cắt, 

vẽ hình chiếu thứ ba khi biết trước hai hình 

chiếu…  

 Hiện tại, các giáo trình vẽ kỹ thuật chỉ 

hướng dẫn cho sinh viên cách vẽ các bài tập 

nói trên bằng tay, không dạy vẽ bằng phần 

mềm máy tính. Vì thế, rất ít sinh viên vẽ đúng 

hình chiếu thứ ba. Hầu hết các giáo viên và 

sinh viên đều thừa nhận rằng vẽ hình chiếu 

thứ ba là rất khó, khi vẽ xong rồi cũng không 

biết chắc kết quả có đúng hay không.  

 Rõ ràng, vẽ hình chiếu thứ ba là khó với 

tất cả mọi người, vì phải tưởng tượng từ 

hình hai chiều sang hình ba chiều.  

 Ngày nay, việc sử dụng máy tính và cài 

đặt các phần mềm ứng dụng không còn xa 

lạ với sinh viên. Dùng máy tính để hỗ trợ vẽ 

và kiểm tra xem hình chiếu thứ ba có đúng 

hay không là việc giảng viên cần phải làm 

và hướng dẫn cho sinh viên cùng làm. Tuy 

nhiên, việc dùng máy tính để vẽ chỉ được áp 

dụng khi sinh viên có kiến thức cơ sở về vẽ 

bằng tay. 

 Sinh viên các ngành kỹ thuật quen 

thuộc với phần mềm Autocad. Đây là phần 

mềm đồ họa dùng cho vẽ 2D và 3D. Tuy 

nhiên, cách vẽ các hình chiếu (bằng, đứng, 

cạnh) và hình cắt của Autocad không được 

tiện lợi như phần mềm Solidworks. 

 Solidworks là một trong những phần 

mềm đồ họa mạnh mẽ nhất hiện nay, 

chuyên dùng để vẽ vật thể ba chiều, mô 

phỏng lắp ráp các chi tiết máy, tạo bản vẽ 

hai chiều từ mô hình ba chiều… 

 Solidworks rất hữu ích cho ta khi vẽ các 

hình chiếu, hình cắt. Solidworks đã cho ta 

lời giải đúng về hình chiếu thứ ba, tạo cho 

người dạy và học môn Vẽ kỹ thuật tâm lý 

thoải mái, hiệu quả học tập cao. 

 Sau đây, chúng tôi trình bày cách sử 

dụng phần mềm SolidWorks 2009 để vẽ 
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hình chiếu trục đo, vẽ hình chiếu thứ ba và 

vẽ mọi hình chiếu, hình cắt theo ý muốn. 

2. Vẽ hình chiếu trục đo khi biết trước 

hai hình chiếu vuông góc 

 Để sát với môn học Vẽ kỹ thuật, chúng 

tôi sử dụng hình ở trong sách Bài tập vẽ kỹ 

thuật xây dựng, Đặng Văn Cứ (chủ biên), 

NXB Giáo dục. Hình như sau: 
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Hình 1 

 Cho hai hình chiếu vuông góc như ở 

hình 1, giáo viên yêu cầu sinh viên về nhà 

vẽ hình chiếu vuông góc thứ ba. Với bài tập 

này, rất nhiều sinh viên vẽ sai các đường 

khuất, đường thấy. Sinh viên cũng không có 

cách nào để kiểm tra xem mình vẽ đúng hay 

sai. Sau đây là từng bước dùng phần mềm 

SolidWorks 2009 để thực hiện cách vẽ các 

hình chiếu.  

 Bước 1: Vẽ hình chiếu trục đo 

 1.1. Khởi động phần mềm SolidWorks 

2009. Theo trình tự, ta thực hiện: Vào menu 

File → New → Part → OK → xuất hiện 

màn hình trắng chuẩn bị vẽ. Hầu hết các 

lệnh vẽ đều nằm trong thanh công cụ 

Command Manager như hình 2. 

 Trên thanh công cụ Command Manager 

có thư mục chủ và thư mục con. Ta dùng 

chủ yếu hai phần của thư mục chủ sau:  

 

 Thư mục con          Thư mục chủ 

Hình 2 

 – Sketch: Vẽ phác thảo. Trong thư mục 

này có rất nhiều thư mục con với các biểu 

tượng công cụ vẽ như hình 2. Ta muốn vẽ 

hình nào thì nhấp chuột trái vào biểu tượng 

hình đó. 

 – Features: Vẽ khối vật thể. Khi nhấp 

chuột vào thư mục này thì có rất nhiều công 

cụ vẽ khối như là: Extrude Boss/Base (tạo 

khối), Extrude Cut (cắt khối), Revolve 

Boss/Base (tạo khối tròn xoay)… 

 1.2. Nhấp chuột vào Sketch trên thư 

mục chủ của thanh công cụ Command 

Manager → nhấp tiếp chuột vào Sketch trên 

thư mục con → xuất hiện trên màn hình ba 

mặt phẳng vuông góc nhau  như hình 3 

(Front Plane, Top Plane, Right Plane) → 

Nhấp chọn Front Plane → ta được màn hình 

sẵn sàng để vẽ. 

 1.3. Ta bắt đầu vẽ hình chiếu trục đo từ 

hai hình chiếu vuông góc ở hình 1. Có nhiều 

cách yêu cầu Solidworks 2009 vẽ hình này. 

Theo tác giả, thực hiện từng bước sau đây là 

ngắn gọn và dễ hiểu nhất: 
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Hình 3 

 Dùng biểu tượng đường thẳng  để vẽ 

phác mặt bên như hình 4, chỉ cần vẽ gần 

giống, không quan tâm tới kích thước: 

 

Hình 4 

 1.4.  Vẫn ở chế độ vẽ phác (tức cả hai 

chữ Sketch ở thư mục chủ và thư mục con 

đều hiện hành), ta tiến hành chỉnh kích 

thước cho mặt bên bằng cách nhấp chuột 

chọn Smart Dimension trên thanh công cụ 

Command Manager → chuột biến thành con 

trỏ có mang theo biểu tượng kích thước → 

ta lần lượt nhấp vào các cạnh của mặt bên, 

khi nhấp cạnh nào thì cạnh đó đổi màu, kéo 

chuột ra ngoài một ít và gõ các kích thước 

như hình 5. 

 
Hình 5 

 Xong, nhấp chọn Exit Sketch trên thanh 

công cụ Command Manager để thoát khỏi 

chế độ vẽ phác mặt bên. 

 1.5. Chọn Features trên thư mục chủ 

của thanh công cụ Command Manager → 

chọn tiếp Extrude Boss/Base (tạo khối)  để 

chuyển sang chế độ tạo khối → nhấp chọn 

một cạnh mặt bên, mặt này sẽ biến thành 

khối → ta nhập số 9  vào ô có biểu tượng 

kích thước  của hộp thoại Extrude phía 

bên trái màn hành như hình 6 để chỉ khối có 

độ dày 9mm.  

 
Hình 6 

 Tiếp theo, ta nhấn nút  trên hộp thoại 

Extrude phía trái màn hình để kết thúc lệnh, 

ta được khối như hình 7.  

 
Hình 7 

 Ở hình 7, ta có thể lăn chuột giữa để 

phóng to, thu nhỏ đối tượng; giữ chuột giữa 

và kéo để di chuyển hay quay đối tượng.   

 1.6. Tiếp theo, ta vẽ phần giữa của chi 

tiết ở hình 1. Ta nhấp chọn mặt (1) ở hình 7, 

mặt này sẽ biến thành màu xanh, ta chọn 

tiếp vào nút  (Normal To) trên thanh 

Standard Views (hình 8) để quay mặt (1) về 

chế độ nhìn trực diện. 

 

Hình 8 

(1) 
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 1.7. Nhấp chuột vào Sketch trên thư 

mục chủ của thanh công cụ Command 

Manager → nhấp tiếp chuột vào Sketch trên 

thư mục con → màn hình chuyển sang chế 

độ vẽ phác. Tương tự như phần trước, ta 

dùng biểu tượng đường thẳng   để vẽ sơ 

bộ vùng (2) như hình 9. 

 

Hình 9  

 1.8. Vẫn ở chế độ vẽ phác, ta tiến hành 

chỉnh kích thước cho vùng (2) mới vừa vẽ ở 

hình 9 bằng cách nhấp chuột chọn nút Smart 

Dimension của thanh công cụ Command 

Manager → chuột biến thành con trỏ có 

mang theo biểu tượng kích thước → ta lần 

lượt nhấp vào các cạnh của vùng (2), khi 

nhấp vào cạnh nào thì cạnh đó đổi màu, ta 

kéo chuột ra ngoài một ít và chỉnh các kích 

thước như hình 10. 

 Nhấp chuột vào nút Exit Sketch trên 

thanh công cụ Command Manager để thoát 

khỏi chế độ vẽ phác. 

 

Hình 10 

 1.9. Tiếp theo, ta chọn nút Features trên 

thư mục chủ của thanh công cụ Command 

Manager → chọn tiếp nút  Extrude 

Boss/Base  để chuyển sang chế độ tạo khối 

→ nhấp chọn một cạnh của vùng (2) ở hình 

9, vùng này sẽ biến thành khối, ta nhập số 

40  vào ô có biểu tượng kích thước  của 

hộp thoại Extrude phía bên trái màn hình để 

chỉ độ dày khối cần tạo là 40 mm. Sau đó 

nhấn nút  trên hộp thoại này để kết thúc 

lệnh, ta được khối như hình 11.  

 

Hình 11 

 1.10. Ta tạo khối bên còn lại bằng cách 

lấy đối lấy đối xứng khối (1) qua mặt trung 

trực của khối (2) ở hình 11. Ta tạo mặt 

trung trực cho khối (2) như sau:  

 Chọn menu Insert → Reference 

Geometry → Plane → nhấp chuột vào 3 

điểm A, B, C là trung điểm 3 cạnh của khối 

(2) để tạo thành mặt phẳng như hình 12. 

Xong, chọn nút  của hộp thoại Plane phía 

bên trái màn hình để kết thúc việc tạo mặt 

trung trực. 

 

Hình 12 

 Tiếp theo, ở mặt trung trực mới vừa tạo 

(SolidWorks tự động đặt tên mặt trung trực là 

Plane 1) → chọn nút Linear Pattern trên 

(1) 

(2) 

Mặt 

trung 

trực 

A 

B 

C 

(1) 

(2) 

(2) 
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thanh công cụ Command Manager → chọn 

tiếp Mirror → chọn vào khối (1) ở hình 12, 

lập tức SolidWorks tạo bóng của khối đối 

xứng có màu vàng. Chọn nút   của hộp 

thoại Mirror phía bên trái màn hình để kết 

thúc lệnh. Kết quả ta được như hình 13. 

 

Hình 13 

 Nhưng sau khi tạo khối đối xứng xong, 

thì mặt phẳng Plane 1 vẫn còn, ta giấu mặt 

này đi bằng cách vào nhấp chuột phải vào 

Plane 1 → xuất hiện hộp thoại → nhấp chuột 

trái chọn biểu tượng chiếc mắt kính  trong 

hộp thoại này, lập tức Plane 1 sẽ biến mất. 

 1.11. Ta nhấp chọn mặt (2) của hình 13, 

mặt này sẽ biến thành màu xanh, ta chọn 

tiếp vào nút  (Normal To) trên thanh 

Standard Views (hình 8) để quay mặt (2) 

sang chế độ nhìn trực diện.   

 

Hình 14 

 Bây giờ, ta vẽ rãnh rộng 40 mm, ở giữa 

phía trên vật thể. Nhấp chuột vào Sketch trên 

thư mục chủ của thanh công cụ Command 

Manager → nhấp tiếp chuột vào Sketch trên 

thư mục con → màn hình chuyển sang chế độ 

vẽ phác. Tương tự như phần trước, ta dùng 

biểu tượng  để vẽ sơ bộ một một hình chữ 

nhật. Xong, nhấp chọn Smart Dimension để 

chỉnh kích thước như hình 14. 

 Nhấp chuột vào Exit Sketch để thoát 

khỏi chế độ vẽ phác.  

 1.12. Tiếp theo, ta chọn Features trên 

thư mục chủ của thanh công cụ Command 

Manager → chọn tiếp Extrude Cut (cắt 

khối) trên thư mục con → Nhấp chọn một 

cạnh hình chữ nhật vừa vẽ, lập tức hình biến 

thành khối, ta nhập số 14  vào ô có biểu 

tượng kích thước  của hộp thoại Extrude 

phía bên trái màn hình để chỉ rãnh muốn cắt 

sâu 14 mm.  Sau đó nhấn nút  trên hộp 

thoại này để kết thúc lệnh, ta được khối đã 

được cắt rãnh như hình 15. 

 

Hình 15 

 1.13. Ta nhấp chọn mặt (1) của hình 15, 

mặt này sẽ biến thành màu xanh, ta chọn 

tiếp vào nút  (Normal To) trên thanh 

Standard Views  (hình 8) để quay mặt (1) 

sang chế độ nhìn trực diện. 

 Bây giờ, ta vẽ lỗ 36 xuyên suốt vật thể. 

Nhấp chuột vào Sketch trên thư mục chủ 

của thanh công cụ Command Manager → 

nhấp tiếp chuột vào  Sketch trên thư mục 

con → màn hình chuyển sang chế độ vẽ 

phác. Ta dùng biểu tượng  để vẽ sơ bộ 

một một đường tròn có tâm là trung điểm 

đoạn AB như hình 16 (SolidWorks tự động 

truy bắt trung điểm).  Tiếp theo, nhấp vào 

(2) 

(1) 
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nút  Smart Dimension trên thanh công cụ 

Command Manager để chỉnh đường kính 

của đường tròn vừa vẽ là 36. 

 

Hình 16 

 Nhấp chuột vào nút Exit Sketch để 

thoát khỏi chế độ vẽ phác.  

 1.14. Tiếp theo, nhấp chọn Features trên 

thư mục chủ của thanh công cụ Command 

Manager → nhấp chọn tiếp Extrude Cut  để 

cắt khối → nhấp chọn đường tròn  tròn vừa 

vẽ, lập tức đường tròn này biến thành khối 

trụ. Ta chọn vào thẻ Through All (cắt hết) 

trong thanh cuộn ở hộp thoại Extrude phía 

trái màn hình như hình 17. 

 

Hình 17 

 Sau đó, nhấn nút  trên hộp thoại này 

để kết thúc lệnh, ta được khối vật thể đã vẽ 

xong như hình 18. 

1.15. Ta ghi kích thước cho vật thể mới vừa 

vẽ như sau: 

 Nhấp chọn Sketch trên thư mục chủ của 

thanh công cụ Command Manager → chọn 

tiếp Smart Dimension → xuất hiện bên trái 

màn hình hộp thoại  Dimension (hình 19) 

→ nhấp chọn tiếp nút Reference dimension. 

 

Hình 18 

 

Hình 19 

 Lần lượt nhấp chọn các điểm đầu và 

điểm cuối để ghi toàn bộ kích thước cho vật 

thể như hình 20.  

 

Hình 20 

A B 
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 Đến đây, ta đã vẽ xong hình chiếu trục 

đo. Ta đặt tên file vừa vẽ là vatthe và lưu 

vào thư mục nào đó trong máy tính. Quy 

trình vẽ của phần mềm SolidWorks đơn 

giản hơn rất nhiều so với vẽ bằng phần mềm 

AutoCad. 

 Bước 2: Dùng hình chiếu trục đo để vẽ 

ba hình chiếu vuông góc 

 2.1. Từ màn hình SolidWorks ở chế độ 

hình 20 → chọn menu  File → New → xuất 

hiện bảng New SolidWorks Document → 

chọn Drawing → OK→ xuất hiện bảng 

Sheet Format/Size → kéo thanh cuộn ở mục 

Standard sheet size, chọn thẻ A4-Landscape 

như hình 21. Xong, nhấn OK.  

 Lúc này, ta có trang giấy A4 nằm ngang 

với đầy đủ khung tên, sẵn sàng cho ta vẽ. 

 

Hình 21 

 2.2. Nhấp chọn View Layout trên thư 

mục chủ của thanh công cụ Command 

Manager → nhấp chọn tiếp Model View → 

xuất hiện bên trái màn hình hộp thoại 

Model View như hình 22.  

 

Hình 22 

 Nhấp đúp chuột trái vào chữ vatthe ở 

hộp thoại Model View (hình 22), kéo chuột 

sang khung bản vẽ bên phải và nhấp thả vào 

3 vị trí của hình chiếu đứng, chiếu bằng, 

chiếu cạnh, cuối cùng là nhấp thả chuột ở vị 

trí thứ 4 để được hình chiếu trục đo. 

 2.3. Tiếp theo, ta nhấp chuột trái chọn 

vào một hình chiếu nào đó → bên trái màn 

hình xuất hiện hộp thoại Drawing View như 

hình 23, ta chọn vào nút Hidden Lines 

Visible để thể hiện nét khuất. Làm tương tự 

với các hình chiếu còn lại.  

 Nhấn nút  ở hộp thoại phía bên trái 

màn hình để kết thúc lệnh.   

 

Hình 23 

 Kết quả ta được bản vẽ gồm các hình 

chiếu như hình 24. Hình này chưa có đường 

tâm và đường kích thước. 

 2.4. Ta vẽ các đường tâm và ghi kích 

thước cho bản vẽ hình 24 như sau: 

 - Vẽ đường tâm: Nhấp chuột vào Sketch 

trên thư mục chủ của thanh công cụ 

Command Manager → nhấp tiếp chuột vào 

biểu tượng Centerline  trên thư mục con 

→ con trỏ sẽ biến thành cây viết, ta kéo 

chuột vẽ các đường tâm như hình 26. 

 – Ghi kích thước: Nhấp chọn 

Annotation trên thư mục chủ của thanh 

công cụ Command Manager → chọn tiếp 

Smart Dimension → xuất hiện bên trái
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Hình 24 

màn hình hộp thoại  Dimension  như hình 

25 → nhấp chuột trái chọn điểm đầu và 

điểm cuối các cạnh để ghi kích thước tất cả 

các hình chiếu như hình 26. Xong, nhấn nút 

  trên hộp thoại  Dimension phía bên trái 

màn hình để kết thúc lệnh.  

 Đến đây, ta đã hoàn thành việc vẽ hình 

chiếu trục đo và các hình chiếu vuông góc. 

Đặc biệt là ta đã dùng hình chiếu trục đo để 

vẽ hình chiếu vuông góc thứ ba bảo đảm 

chính xác hoàn toàn.  

 2.5. Trong trường hợp yêu cầu dùng 

hình cắt để biểu diễn hình chiếu thứ ba thì 

ta làm như sau: 

 Trên màn hình ở hình 26, ta nhấp chọn 

hình chiếu thứ ba, nhấn phím Delete để xóa 

nó đi. Xong, chọn View Layout trên thư 

mục chủ của thanh công cụ Command 

Manager → chọn tiếp Section View trên 

thư mục con → con trỏ sẽ biến thành cây 

viết, ta kẻ một đường theo mặt cắt A – A, 

rê chuột sang phải, nhấn chuột trái và thả, 

ta sẽ được hình chiếu thứ 3 có dạng là hình 

cắt. Nhấn nút  trên hộp thoại  Section 

View phía bên trái màn hình để kết thúc 

lệnh. Tiến hành vẽ thêm đường tâm và 

chỉnh kích thước, ta được bản vẽ đầy đủ 

như hình 27. 

 

Hình 25 
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Hình 26 

 

 

Hình 27 
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3. Kết luận 

 Bài báo này giải quyết được khó khăn 

cho việc dạy và học môn Vẽ kỹ thuật về 

các vấn đề: 

 – Vẽ hình chiếu trục đo khi cho trước 

hai hình chiếu vuông góc. 

 – Vẽ hình chiếu thứ ba khi cho trước 

hai hình chiếu vuông góc. 

 – Vẽ ba hình chiếu vuông góc khi cho 

trước hình chiếu trục đo. 

 – Lập bản vẽ đầy đủ gồm ba hình 

chiếu vuông góc có kèm theo hình vật thể 

3D ở vị trí thứ tư. 

 – Vẽ đúng hình cắt. 

       Đồng thời, bài báo này cũng chia sẽ 

với độc giả về kinh nghiệm khai thác phần 

mềm SolidWorks 2009 để vẽ hình 3D, tạo 

điều kiện cho độc giả có thêm tư liệu thiết 

thực, đáp ứng yêu cầu trong giảng dạy và 

học tập. 

* 

DEVELOPING THREE-DIMENSIONAL OBJECT MODELS, THE THIRD 

DIMENSION AND SECTIONAL DRAWING IN TECHNICAL DRAWING 

Ngo Bao 

Thu Dau Mot University 

ABSTRACT 

 SolidWorks 2009 software is an application of information technology to measurement 

axis projection drawing, third dimension projection drawing, drawing of all protections 

and sectional drawing as desired, contributing to resolve problems in the teaching and 

learning of technical drawing. This article introduces how to use the SolidWorks 2009 

software to draw a  measurement axis projection when knowing two perpendicular 

projections in 2 steps: Step 1, draw a measurement axis projection in 15 actions; Step 2, 

use the measurement axis projection to draw three perpendicular projections in 5 actions. 

With the use of the SolidWorks 2009 software, we will solve difficulties of technical 

drawing in the case of the measurement axis projection drawing, third dimension drawing 

upon given two perpendicular projections and drawing three perpendicular projections 

upon given the measurement axis projection. 
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